
SUBJECT:  GeorgiaFIRST HRMS Project Release 3.25 
 
PURPOSE:  Release of BOR fixes and enhancements (see details below).   
 
TECHNICAL IMPACT: 
 

DATABASE:   Your PeopleSoft HRMS database has been upgraded with BOR Release 3.25, and is 
available.  You can verify your release level by navigating to any page, hitting [CTRL][J], and verifying 
the last three digits of the Application Release field.  Please note: during the release process, all server-
side cache files are deleted; this may cause performance issues during initial page loads. 
 
WORKSTATION:  As with any release, we recommend clearing your internet browser cache files 
before logging in to your database. 
 
SECURITY: Security modifications are a part of this release.  See details below. 
 

Functional Fixes and Enhancements 
 
Modifications to Existing BOR Functionality:   
 
Acct Dist Report by Options (BORRF96C) – This report is modified so that it can be run by Project/Grant id. 

This is in response to Model Change Request #660.   
 
Badge Search page – The search record for the Badge page is modified to allow users to pull up any 

employee’s badge page for review and modifications. Prior to the modifications, users were only able to 
pull up employees who had records in the BADGE_TBL table. 

 
BlueCross/BlueShield Interface process (BORI021) – This process is modified to use HMAD as the Product 

ID in the file when the health plan enrolled is HMO Consumer Choice. Prior to the modifications, HMAH 
was used for HMO Consumer Choice plan, which caused BCGSGA having problems loading the correct 
plan to QCare. This modification is in response to BCBSGA’s request. 

 
CA Annual File (BORIF03N) – This  process was modified in response to the recent State Audit request by 

adding SSN back to the file, removing Emplid and the Trans Code/Card Code field from the file, and 
changing the file layout from fixed-width to comma delimited.  This modification was delivered on March 
8, 2007, via Interim Release 3.24a. Business process RPT 315 – Continuous Audit has been modified to 
reflect the changes. 

 
CA Annual Temp Table (BORIF03J) – This process was modified in response to the recent State Audit request 

by adding SSN back to the file and removing Emplid. Trace file was modified to identify errors for SSNs 
beginning with 999 or 888 and Job Codes of 999X. The temp table will also correctly display negative 
amounts with a leading negative symbol (-) before the first numeral EX: -4352.22.  This modification was 
delivered on March 8, 2007, via Interim Release 3.24a. Business process RPT 315 – Continuous Audit has 
been modified to reflect the changes. 

 
CA Quarterly Temp Table (BORIF03A) – This process was modified in response to the recent State Audit 

request by adding SSN back to the file and removing Emplid. Trace file was also modified to identify 
errors for SSNs beginning with 999 or 888 and Job Codes of 999X.  This modification was delivered on 
March 8, 2007, via Interim Release 3.24a. Business process RPT 315 – Continuous Audit has been 
modified to reflect the changes. 

 
Case Status Mass Update – Case Status Review Search page – This search page has been enhanced to allow 

users to search based on Case Type and Case Status using the dropdown fields. Prior to the modifications, 
both Case Type and Case Status fields were free-form text field. Users were required to type in the exact 
Case Type and/or Case Status in order to search. 

 



Charitable Contributions (BORI011) – This process is modified to exclude non-employees from the file. Prior 
to the modifications, non-employees such as COBRA participants were included in the file generated. 

 
Create ERS/DEFCON File (BORIF28D) – This process is modified in response to the ERS new reporting file 

format.  The PER and CON files have been consolidated into one file for ERS reporting.  Trace file is 
modified to: 1) identify errors from the records which are not included in the extract file, 2) identify 
EmplID’s where the Contribution Salary * Benefit Rate does not match the Paycheck Deduction; and 3) 
provide totals by Benefit Plan and Total Detail Records, including Count, IRS Overage, Total Earnings, 
Total Employee Contributions and Total Employer Contributions.  

 
A new page, IRS Limit, has been created to allow users to maintain and store the annual IRS limits.  A 
script has been created and run against the database to load the FY07 limits for the ERS and ERSOLD 
plans. Path to the new IRS Limit page is: Setup HRMS>Product Related>Base Benefits>Plan 
Attributes>Retirement Plan Table>ERS and ERSOLD plans. Business process RPT 310 – ERS_DEFCON 
Retirement Reporting has been modified to reflect the new process changes. 

 
Note: Updates to the IRS Limit page for the ERS and ERSOLD plans for FY08 will be provided to 
GaFIRST institutions via Foundation Table Additions/Changes – FY07.03. 

 
Create ERS/DEFCON Report (BORIF28F) – This report is modified in response to the ERS new reporting 

requirements.  Fields added to report are Plan Elig Date, Plan Term Date, Payment Reason, Percent Time 
and Monthly ER Contribution.  Fields removed from the report are Rcd Typ, Trxn Code, Dept Code, 
Location Code, Provdr Code, Rtr Sys, Month Base Compensation and Empl Perc.  Column headers on the 
report are also modified to provide a clearer definition of contents. Column labels changes are:  

 
Old Column Heading New Column Heading 

Reporting Date Posting Month 
Month Cont Earnings Contribution Salary 
Monthly Contribu Monthly EE Contribution 
Flag Trace File Flag 

 
Trace file is modified to identify errors from the records which are not included in the extract file. Business 
process RPT 310 – ERS_DEFCON Retirement Reporting has been modified to reflect the new process 
changes. 

 
Create ERS/DEFCON Temp Table (BORIF28A) – This process is modified in response to the ERS new 

reporting file format.  New fields are added to the ERS_BOR table.  This process is also modified to pull 
the National ID from the PERS_NID table instead of the PAY_CHECK table.  

 
A script has been created and run against the database to load the FY07 limits for the ERS and ERSOLD 
plans. Path to the new IRS Limit page is: Setup HRMS>Product Related>Base Benefits>Plan 
Attributes>Retirement Plan Table>ERS and ERSOLD plans.  Business process RPT 310 – ERS_DEFCON 
Retirement Reporting has been modified to reflect the new process changes. 
 
 (Important: User must run the Refresh EMPLOYEES Table process, PER099, using current System Date 
prior to running this process.)   
 
Note: Updates to the IRS Limit page for the ERS and ERSOLD plans for FY08 will be provided to 
GaFIRST institutions via Foundation Table Additions/Changes – FY07.03. 

 
Create State File (MMREF) program (TAX960ST) – This process was modified to temporarily resolve the 

issue of file being rejected by State of GA before PeopleSoft releases the official program change.  This 
modification was delivered on March 8, 2007, via Interim Release 3.24a 

 
Create TRS/ORP File (BORIF04D) – This process is modified to correctly apply annual IRS limits for TRS 

and ORP participants when generating the file. A new page, IRS Limit, has been created to allow users to 



maintain and store the annual IRS limits.  A script has been created and run against the database to load the 
FY06 and FY07 limits for TRSLMT plan, and CY05 and CY06 limits or the ORPLMT plan. Path to the 
new IRS Limit page is: Setup HRMS>Product Related>Base Benefits>Plan Attributes>Retirement Plan 
Table>TRSLMT and ORPLMT plans.   
 
Note: Updates to the IRS Limit page for the ORPLMT(CY07) and TRSLMT(FY08) plans will be provided 
to GaFIRST institutions via Foundation Table Additions/Changes – FY07.03. 

 
Create TRS/ORP Report (BORIF04F) – This report is modified to correctly apply annual IRS limits for TRS 

and ORP participants when generating the report.  
 
Edit ERS/DEFCON Temp Table – PeopleCode behind the page is modified to correctly report employee 

birthdates. Prior to the modifications, when a change was made to the temp table, birthdates of employees 
who were born in 30’s and 40’s would be changed from 19XX to 20XX. Also in response to the ERS new 
reporting requirements, new fields for edit are added while some fields have been removed. Fields now 
allowable for edits are: EmplID, Plan Code, Posting Month, Pay Reason, %Time, Earnings, Employee 
Contrib and Employer Contrib.  Fields removed from Edit ERS/DEFCON Temp Table page are: Soc Sec#, 
Address 1, Address 2, City, State, Postal Code, Birthdate, Hire Date, Term Date, Gender, Compensation 
and Percent.  Business process RPT 310 – ERS_DEFCON Retirement Reporting has been modified 
accordingly to reflect the new process changes. 

 
Employment Information page – Three additional values are added to the Security Clearance dropdown field:  
 

1) Confidential           
2) Position of Trust Limited 
3) Position of Trust Standard 

 
FSA Benefits (USA) page – PeopleCode behind this page is modified to give a warning message of ‘Warning -
- This employee has a history record that has contradictory data. Click OK to ignore. (25000,96)’ when saving 
an employee’s records which have erroneous history data. Prior to the modifications, user received an error 
and was unable to proceed with saving the records. A DBI would be required to make the changes to the 
record. 
 
Leave Accrual Summary Report – Dept report (BORR026A) – This report is modified to ensure that all 

employees are correctly reported in their current location. 
 
Payroll Deduction Register report (BORR022) – This report is modified to correctly list the employer 

deductions per paycheck when multiple paychecks were issued in the reporting period. 
 
Populate Tenure Data process (BORM018) – This process is modified to include the case status of Campus 

Approved which is used for the Promotion case type.  Rank changes for campus approved promotions will 
be updated on the Create Tenure Data page through this process.  Business process HR 430 – Running the 
Populate Tenure Data Process has been modified to reflect the new process changes. 

 
Retirement Plan Table page – A new tab of IRS Limit is added to allow users to maintain the IRS limits for 

ERS(FY), TRS(FY) and ORP(CY) participants respectively. Path: Setup HRMS>Product Related>Base 
Benefits>Plan Attributes>Retirement Plan Table>TRSLMT and ORPLMT plans. A script has been created 
and run against the database to load the FY06 and FY07 limits for ERS and TRSLMT plan, and CY05 and 
CY06 for the ORPLMT plan.  

 
Note: Updates to the IRS Limit page for subsequent years will be provided to GaFIRST institutions via 
Foundation Table Additions/Changes. 

 
 

Self-Service Functionalities 
 



This section lists the enhancements and fixes delivered in this release for the Self-Service functionalities: 
 
Self Registration 
 

o Self Registration is modified to allow employees to register even when their Primary Job is not the 
same as their Empl Rcd 0.  Previously, employees that had a Primary Job on an Empl Rcd other than 
0 were eliminated from the Self Registration process.    

 
 
Personal Information Home 
 

o Address Change – The Address Change page is modified so that employee can only enter a current or 
future effective date for address changes. Please note that HR 205 – Hiring a New Employee has been 
modified (see below) to include a workaround that will be required when making address changes 
with an effective date prior to the system date through the Employee Portal. 

 
o Marital Status Change – PeopleCode is modified so that the effective date that is entered will not only 

populate the Effective Date on Personal History page, but will also populate the Marital Status As of 
Date.    

 
Payroll and Compensation Home 
 

o Direct Deposit – PeopleCode behind the page is modified so that the Prenotification Required 
checkbox in the Employee Portal will automatically be checked for any direct deposit change made 
through Self Service.  Previously, if an employee made a self service change to a direct deposit 
account that had the Prenotification Required checkbox off on a previous row, the new row carried 
over the attribute of having the Prenotification Required box checked off.     

 
o On-line Paycheck 

 Leave Balance is represented the way that leave is currently shown on the PAY003/DDP003 
as Begin Balance +Earned – Taken = Ending Balance.  

 Leave Balances are not shown on prior period checks. 
 

o Payroll and Compensation Home – Verbiage is added to inform user that YTD balances will only be 
shown on the most recent paycheck.  Verbiage added reads: “Note: YTD and leave balances are only 
shown on your most recent paycheck.” 

 
o Print-Friendly Paycheck – 

 Company Name is added 
 Leave Balance is represented the way that leave is currently shown on the PAY003/DDP003 

as Begin Balance +Earned – Taken = Ending Balance.  
 Leave Balances are not shown on prior period checks. 

 
o Voluntary Deduction page – Verbiage is added to clarify how the Goal Balance Field is used on this 

page.  Verbiage added reads “The goal balance reflects the balance from the specific pledge shown.  
This will not represent the YTD amount that has been deducted due to prior pledges.” 

 
Worklist Related 
 

o W-2 Reissue Request Worklist – In the Employee Portal, the worklist link is modified to inform the 
user of where the employee would like their reissued W2 sent.  

 
Miscellaneous 
 

o Compensation History menu link – This link is removed from the left-side menu following the path: 
Self Service->Employee->View. Prior to the modifications, self service users were able to see the 



Compensation History link on the left-side menu even though the Compensation History page had 
been removed from the Payroll and Compensation Home via security model. When employees 
clicked on the link, they would receive the error of “You are not authorized for this page”, which 
caused confusions to the employees. 

 
Security Fixes and Enhancements 

 
Modifications to Model Security:  
 
BORDBB10 (Dfn Base Ben – Set) – This permission is modified to add the new IRS Limit page on the 

Retirement Plans table page. 
 
BORDBB11 (Dfn Base Ben – Set co) – This permission is modified to add the new IRS Limit page on the 

Retirement Plans table page. 
 
BORDBB19 (Dfn Base Ben – Set RO) – This permission is modified to add the new IRS Limit page on the 

Retirement Plans table page. 
 
 
RELEASE DOCUMENTATION:  Detailed Release documentation is available at the HRMS/GeorgiaFIRST 

website: http://www.usg.edu/gafirst/hrms - Release Information - Current Release.   

The following business processes have been recently created or updated, and are available for 
viewing on our website: 
 

• HR 205 – Hiring a New Employee – Modified to include a workaround that will be required 
when making address changes with an effective date prior to the system date through the 
Employee Portal.  This workaround is required due to limitations placed on the Address 
Effective date entered through Self Service 

• HR 430 – Running the Populate Tenure Data Process – Revised on page 2 to add a new 
"Campus Approved" option to the Case Status group box in Step 1. Also revised the existing 
"BOR or USO Approved" option to read "BOR or USO or Campus Approved." 

• HR 605, HR 610, HR 615, and HR 620 – Self Service Business processes - All Self Service 
business processes have been modified to explain how an approver becomes the owner of a 
worklist item.  This information is included in the General Information section.   

• PAY 435 – Setup and Maintain Direct Deposit – Revised on Step 1 on page 2 to reflect the 
fact that PS validates that the Bank Routing number meets the ACH guidelines for ABA #’s, 
but does not validate that the number is in fact legitimate. Also added details regarding the 
Suppress DDP Advice Print box in the General Information section on page 3. 

• PAY 530 – Calendar Year End Checklist – Revised to highlight the new changes that no 
diskette file should be transmitted to the Georgia Department of Revenue by institutions who 
have 250 or more income statements to report. 

• RPT 310 – ERS_DEFCON Retirement Reporting – Revised in response to the ERS new 
reporting file format. 

• RPT 315 – Continuous Audit – Revised pages 1, 2, 4, 5 and 6 to include the changes to the 
programs (BORIF03A, BORIF03J, and BORIF03N) 

• RPT 340 – Account Distribution Reporting – Revised to include information about the 
modification made in response to Model Change Request #660 that allows user to run the 
Account Distribution Report by Option by Project/Grant ID. 

• RPT 355 – SSN Verification Interface – New business process created to describes the steps 
necessary to run the Employee SSN Verification Interface (SSNVS) process and submit the 
resulting data file to the Social Security Administration online on an on-demand basis. 

 
Note: A summary of changes to the Business Processes may be viewed by clicking the ‘here” link 
displayed at the top of the Business Process when opened directly from the HRMS web site.  The 



changes may also be viewed by opening the Business Process and going to 
File>Properties>Summary>Comments. 

 
The following other documentation has also been recently created or updated, and is available for 
viewing on our website: 
 

 HRMS Self-Service – (Project Information>HRMS Self-Service (eApps) Phase I>Sample 
Training & Communication or Documentation>Training) 

o Employee Self-Service Help document – Updated to reflect changes to Self Service 
included in this release (Release 3.25).  Please note that if you are using this Help 
Document as a Self Service Training manual on your school’s Self Service website, 
you will need to make any institution specific changes and re-post to your website.  

 
• Known Issues – (Documentation>Known Issues) 

o KI0071 - Diskettes from institutions reporting 250 or more income statements will 
not be accepted by State of Georgia due to recent changes to State of Georgia Wage 
and Tax Reporting requirements. 

o KI0072 - 3rd Biweekly Payroll Should Not be Combined with Monthly Pay Groups 
o KI0073 - ERS New Pension System (P.A.R.I.S.) and Parallel Testing 

 
NEXT SCHEDULED RELEASE: The next scheduled release for Version 8 – 3.26 – is tentatively scheduled 
for July 23, 2007. 


